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SAŽETAK: Tema ovog završnog rada je obrada fotografija za komercijalnu namjenu. Rad 

obuhvaća pregled povijesti retuširanja fotografija, tj. kako se obrada fotografija mijenjala 

tijekom godina, kako su izgledali sami počeci obrade fotografije, te koji se sve alati danas 

koriste za obradu fotografije. Detaljno će se opisati sam proces retuširanja fotografija u 21. 

stoljeću, te će se usporediti izgled modela u realnom svijetu s onim s naslovnica časopisa. 

Prikazat će se primjeri pretjerane obrade fotografija koja je rezultirala neprirodnim izgledom 

modela. Bez obzira na način života koji modeli moraju održavati, konstantan strog režim 

prehrane  i ekstremno vježbanje kako bi postigli “savršeno tijelo”, reklamne agencije i 

korporacije ipak insistiraju na dodatnom obrađivanju fotografija kako bi modeli izgledali 

mršavije, ljepše, ili “savršenije”.  Praktični dio završnog rada obuhvaća obradu fotografija 

portreta studentice Grafičkog fakulteta, koristeći se trikovima i alatima retušera poznatih 

časopisa. 

 

KLJUČNE RIJEČI: fotografija, retuširanje fotografija, časopisa, Photoshop  



Sadržaj 

 

1. UVOD……………………………………………………………………………….......1 

2. TEORIJSKI DIO………………………………………………………………………..2 

 2.1 POVIJEST RETUŠIRANJA FOTOGRAFIJA……………………………….…2 

  2.1.1. Počeci…………………………………………………………………2 

  2.1.2. Evolucija………………………………………………………………5 

  2.1.3. Digitalno retuširanje fotografija……………………………………..10 

 2.2 PROCES RETUŠIRANJA FOTOGRAFIJA…………………………………..12 

  2.2.1. Retuširanje beauty fotografije- Lice …………………………….…..13 

 2.3 VELIKE FOTOGRAFSKE POGREŠKE RETUŠIRANJA TIJEKOM 

GODINA...................................................................................................................27 

3. EKSPERIMENTALNI DIO…………………………………………………..…………29 

 3.1 OPĆI CILJEVI RADA………………………………………………...……….29 

 3.2 OPREMA………………………………………………………………………29 

 3.3 OBRADA FOTOGRAFIJA……………………………………………………30 

4. REZULTATI…………………………………………………………………………….41 

5. ZAKLJUČAK…………………………………………………………...………………41 

6. LITERATURA…………………………….……………………………………………42 

 



1 
 

1. UVOD 

Retuširanje fotografija postoji već godinama, no u posljednje se vrijeme spominje u 

kontekstu brojnih kontroverzi. Slavne osobe i modeli se retuširaju  na raznorazne načine: na 

fotografijama za online reklame, časopise i slično. Danas postoji velik broj načina 

oglašavanja a tehnologija se neprestano razvije u korak s potražnjom, a s razvojem 

tehnologije raste i broj konzumenata različitih dobi. Ovaj rad nastoji prikazati kako se proces 

retuširanja fotografija razvijao od samih početaka pa sve do danas, koji su se alati pritom  

koristili te kako se iskustvo i znanje o umijeću retuširanja fotografija mijenjalo s jednim 

zajedničkim ciljem: da nesavršenosti naprave savršenima. 
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2. TEORIJSKI DIO 

2.1. POVIJEST RETUŠIRANJA FOTOGRAFIJA 

2.1.1. Počeci 

Englez William Henry Talbot je 1841. godine patentirao kalotip- prvi praktični fotografski 

proces kojim se stvarao negativ koji je potom mogao proizvesti više kopija. Pet godina 

kasnije, 1846., njegov velški kolega Calvert Richard Jones, ili pak netko od Jonesovih 

suradnika, izvodi prvo poznato retuširanje fotografije. Jones je fotografirao petoricu fratara 

kapucina na krovu na Malti; četvero fratara je stajalo jedan do drugoga međusobno 

razgovarajući, dok je peti fratar stajao nekoliko koraka iza njih, čudno ih nadvisivši. Jonesu, 

ili pak nekome od njegovih suradnika, se nije sviđao način na koji peti fratar kvari 

kompoziciju fotografije pa je tušem zamrljao fratrovu siluetu na negativu fotografije, te se 

tako na pozitivu peti fratar uklopio u svjetlost neba.  

Može se dakle zaključiti da retuširanje fotografija postoji koliko i sama fotografija, no na 

početku se nije koristila tehnologija koja se koristi danas, već se retuširanje obavljalo na 

samom negativu fotografije. Fotografi i retušeri bi nožem grebli film, crtali ili bojali po 

njemu, ili bi čak lijepili više negativa zajedno kako bi dobili konačnu fotografiju. Postupak 

nastanka fotografije pomoću mokrog kolodija bio je najpopularniji način razvijanja 

fotografije od izuma te tehnike 1851. godine pa sve do 1870-ih. Fotograf bi negativ dobivao 

tako što bi staklenu ploču prekrio organskom tvari - kolodijem, takvu je  potom umakao u 

srebrov nitrat kako bi postala svjetlosno osjetljiva te bi tako tretiranu ploču stavljao u 

fotoaparat. Takve „mokre ploče“ bilo je potrebno eksponirati svjetlu i razviti u roku od 10 

minuta, pa su tadašnji fotografi morali koristiti prijenosne tamne komore.[1] 

Jedan od prvih umjetnika koji su koristili tehnike slaganja u fotografiji je Henry Peach 

Robinson. Njegova najpopularnija fotografija nastala tehnikom slaganja je „Fading Away“. 

Nastala je u tamnoj komori pomoću tehnike zvane kombinirani tisak. Ta je tehnika omogućila 
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Robinsonu da kombinira elemente različitih negativa kao i da namjesti ekspoziciju s ciljem 

da stvori fotografiju koja će savršeno utjeloviti njegovu viziju.[2] 

Slika 1- „Fading Away” autora Henryja Peacha Robinsona, 1858. 

Početkom 1880. godine, takozvani „dry plate process“, u kojem se staklena ploča oblaže 

želatinom i emulzijom srebrnog bromida te se ostavlja da se osuši, zahvaljujući svojoj 

jednostavnosti postaje vodećom metodom razvijanja fotografija. Oba procesa koristila su 

staklene negative, pogodne za ručne prepravke. Stakleni negativi su bili veoma rašireni sve 

do 1913., kada je porasla popularnost plastičnih negativa koji su se ručno retuširali na isti 

način kao i oni stakleni. Proces retuširanja je započinjao jednako bez obzira o vrsti negativa 

koji se prepravljao. Nakon okidanja fotografije, fotograf bi negativ tretirao kemikalijama te 

mu dodavao fiksir kako više ne bi bio osjetljiv na svjetlost. 

Neki bi fotografi tada premazivali negative i tako dodavali zaštitni sloj prije samog 

retuširanja, dok bi drugi pak obavljali izmjene na samom negativu pa tek onda dodavali 

zaštitni sloj. Taj se posao obavljao na stolu za retuširanje. Središnji drveni okvir stalka ležao 

je na drvenim nožicama povezanih šarkama koje su umjetniku omogućavale da izmjeni nagib 

radne površine. Na središnjem okviru se nalazila staklena ploča na koju se stavljao negativ, 
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dok je na bazu stola bilo pričvršćeno zrcalo ili komad bijelog kartona koji bi reflektirali 

svjetlost kroz negativ. Drvena ploha koja se nalazila na gornjoj strani stola,  na koji bi često 

bile pričvršćene zavjese ili nekakva tkanina koja bi prikrivala cijeli stol, sprečavala bi 

prodiranje svjetlosti s gornje strane samog negativa. 

Kada bi htio pristupio retuširanju, fotograf, ili retušer, bi postavio stol ispred prozora 

okrenutog prema sjeveru, pošto je vodič za retuširanje iz 1898. navodio da je  svjetlo sa 

sjevera najstabilnije. Retuširanje se uglavnom odvijalo na strani negativa koji je bio 

prekriven emulzijom. Najprije bi se ispravljali oni dijelovi fotografije koji su bili presvijetli, 

i to obično prije premazivanja zaštitnim slojem. Kako razvijanjem fotografije tamna područja 

na negativu postaju svjetla, i obratno, ukoliko je fotograf htio „smanjiti“ tamno područje na 

negativu, to bi napravio pažljivim nanošenjem praha sipine kosti ili pak krede u prahu. 

Kako bi posvijetlio manje dijelove negativa, retušer bi koristio oštricu kako bi ostrugao film 

i na taj način te dijelove potamnio u završnoj verziji fotografije. Za precizne detalje, fotograf 

bi koristio nožić sličan kirurškom skalpelu. Taj je proces struganja zahtijevao visoki stupanj 

preciznosti i mogli su ga obavljati samo iskusni majstori retuširanja, te je bio posebice tražen 

za „peglanje“ ondašnjih portreta. „Camera Magazine“ iz 1904. godine tako navodi da 

profesionalni fotografi najčešće koriste oštricu kako bi suzili struk svojih gojaznijih klijentica  

.  

Slika 2- „Sužavanje krupnijih klijenata“ Izvor: „Complete self-instructing library of 

practical photography”.Archive.org// Public Domain 
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Časopis “The New Photo Miniature” iz 1913. godine navodi sljedeće: „Može se sa 

sigurnošću reći da je nožić za struganje jedan od najkorisnijih alata na području retuširanja 

fotografija i nemoguće je nabrojiti sve njegove prednosti; ukoliko razroki muškarac ili žena 

žele ispraviti taj nedostatak, netko pak želi popraviti kukast nos ili pak prenaglašenu čeljust 

, maknuti vlas koji strši , izoštriti subjekt koji se taman pomaknuo pri fotografiranju, maknuti 

ili ublažiti neželjene dijelove figure, i još štošta“. Jednom kad retušer dovrši prosvjetljivanje 

željenih područja, tada se kreće s potamnjivanjem grafitnom olovkom ili kistom namočenim 

u tuš ili vodenu boju. No prije svega, trebalo je pripremiti podlogu negativa kako bi se boja 

primila.  

Kako bi površinu negativa napravio dovoljno hrapavom da apsorbira boju, fotograf bi je 

najprije lagano ostrugao kamenom plavcem ili sipinom kosti. Većina njih je koristila i medij 

za retuširanje: tekućinu na bazi terpentina pomiješanog s balzamom ili smolom koja se mogla 

lako ukloniti u slučaju pogreške. Ukoliko je fotograf nanio previše grafita, mogao je 

terpentinom lako ukloniti medij za retuširanje, obrisati negativ, nanijeti još medija i krenuti 

ispočetka. Osobe koje su se bavile retuširanjem bi koristile različite pokrete i tehnike 

olovkom, od sjenčanja kosim crtama, spiralama ili točkama kako bi se doskočilo različitim 

problemima.  

2.1.2. Evolucija 

Vodič za retuširanje iz 1919. navodi da je ključ uspjeha u retuširanju lagani dodir jer „ukoliko 

su izmjene napravljene pregrubo, to će se vidjeti na razvijenoj fotografiji. Zbog toga mnogi 

portreti nakon retuširanja izgleda kao da subjekt ima ospice“. Prvenstveno su se retuširali 

portreti, i dok su fotografi i kritičari raspravljali o etičnosti i primjerenosti pretjeranog 

retuširanja, ono se prvenstveno koristilo za ispravljanje nepravilnosti na koži i za micanje 

piegica na licu. Nakon ispravljanja takvih nepravilnosti, kao i eventualnih izobličenja na 

negativu nastalih zbog prašine, fotograf bi pristupio „ispravljanju“ lica i tijela subjekta, 

popravljajući eventualne tjelesne defekte i suptilno (ili ponekad ne baš toliko suptilno) 

izmjenjujući određene dijelove tijela. Nos, uši, čeljust, vrat i ramena bi se izmjenjivali u 

skladu s standardima ljepote tog vremena, bore bi se smanjivale ili potpuno uklanjale, dok bi 
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se izbočene kosti ili tetive poravnale. Zaluđenost retuširanjem je 1870-ih bila u punom jeku 

u Europi kao i SAD-u, gdje su kupci inzistirali na retuširanju svojih portreta.  

“To je zaluđenost koja uvelike otežava posao fotografu“, pisao je njemački stručnjak za 

retuširanje dr. H. Vogel za časopis „The Photographic Journal of America“ u ožujku 1870. 

No dr. Vogel je hvalio umjetnost retuširanja, naglašavajući da, dok su glumice izvrsni modeli, 

„dame iz privatnog života su sasvim druga priča. Čudno poziraju ispred kamere ili pak posve 

odbijaju fotografove prijedloge, ne daju se namjestiti te im, unatoč osvjetljenju, koža na 

negativu izgleda kao netom izorano polje. U takvim situacijama se retuširanje negativa 

pokazalo spasonosnim“. Henry Hunt Snelling, istaknuti urednik i autor brojnih članaka o 

fotografiji te autor jednog od prvih praktičnih priručnika o dagerotipnoj fotografiji, bio je 

žestoki protivnik retuširanja, što je i obznanio na stranicama časopisa „The Philadelphia 

Photographer“. Za njega je potreba za retuširanjem fotografije bio pokazatelj nesposobnosti 

fotografa koji je tu fotografiju i okinuo.  

“Čovjek koji ne može razviti pozitiv koji odgovara negativu a da pritom taj isti negativ ne 

retušira, nije vrijedan nazvati se fotografom“, podrugljivo je komentirao u broju iz ožujka 

1872. Drugi su pak fotografi komentirali da pretjerano retuširanje svakako predstavlja 

problem, no manje korekcije su opravdane ukoliko su “izmjene načinjene na negativu 

neprimjetne na finalnoj fotografiji“. „Za portretnu je fotografiju retuširanje gotovo 

neizbježno. Danas možemo reći da, ukoliko želimo proizvesti dobar portret, rad na negativu 

nije samo opravdan, već i neophodan“, piše autor vodiča za fotografiju iz 1881. godine. 

„Jedino pitanje koje se nameće je gdje podvući crtu.“ Brojni su časopisi i priručnici nastojali 

odgovoriti na to pitanje, neki pomoću primjera, dok su drugi pribjegli zajedljivim 

komentarima, posebice kada se radilo o uklanjaju bora.  

Neki su fotografi zagovarali korištenje leća mekanog fokusa umjesto retuširanja, pa tako 

autor članka u časopisu „Popular Photography“ iz 1915. navodi da se uz pomoć leća mekanog 

fokusa „mogu zadržati obrisi i obilježja subjekta, umjesto da se oni izmjenjuju prema ukusu 

osobe koja te fotografije retušira“. Bez obzira na to, ukoliko su klijenti htjeli postići određen 
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izgled, retuširanje je bilo neizbježno. Brojni su se fotografi složili s Frederickom C. Davisom 

koji je u časopisu „Photo Era Magazine“ iz 1920. izjavio da je retuširanje „nužno zlo“. [1] 

Fotografija glumice Joan Craford koju je George Hurell okinuo 1931. godine predstavlja 

jedan od najpoznatijih primjera tzv. „glamour“ retuširanja u Hollywoodu. Postizanje 

savršenog izgleda je postalo imperativom davno prije nego što je Photoshop ušao u igru. 

James Sharp, Hurrellov stručnjak za retuširanje, izgladio je Crawfordino lice i  smanjio bore 

kako bi izgledala mlađe koristeći vibrirajući aparat za retuširanje koji mu je omogućavao da 

ručno bojom izbriše nepravilnosti na licu, pjegice i bore.  

 

Slika 3: Portret glumice Joan Crawford fotografa Georgea Hurrella, 1931. 

Ansel Adams, majstor tehnika oslabljivanja i pojačavanja u tamnoj komori, proslavio se 

svojim izvanrednim  fotografijama krajolika. Radi se o fotografu koji je izumio tehniku 

sustava zona, kao i usavršio tehnike oslabljivanja i pojačavanja u tamnoj komori. Njegov 

način retuširanja i obrade negativa učinilo je njegove fotografije dinamičnijima i 

atraktivnijima. 
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Slika 4: Ansel Adams s originalnom i finalnom verzijom svoje fotografije „Moonrise“, 

1941. 

Još jedan od poznatih primjera fotografija retuširanih u tamnoj komori je portret Jamesa 

Deana na ulicama New Yorka, fotografa Dennisa Stocka. U to vrijeme bilo je uobičajeno da 

fotografi daju podrobne upute retušerima o tome koje dijelove fotografije trebaju posvijetliti 

a koje potamniti. 

 

Slika 5: Portret Jamesa Deana, fotograf: Dennis Stock, 1955. 
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Prije Avedona, modna je fotografija bila obična i dosadna, te bi podrazumijevala običnu 

fotografiju modela. Avedon je u modnu fotografiju unio oblike i pokrete te se proslavio 

inovacijama u pogledu kreativnog retuširanja, poput zamagljivanja, izobličavanja i foto-

montaže, kao što je vidljivo iz fotografije glumice Audrey Hepburn na slici ispod: 

 

Slika 6: Audrey Hepburn, fotograf: Richard Avedon, 1967. 

Avedon je poznat i po svojim ekspresivnim portretima koji su bili pažljivo retuširani 

tehnikama oslabljivanja i pojačavanja kako bi se postigla željena dubina i kontrast. Na slici 

ispod je prikazan primjer njegovih bilješki retušeru: 
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Slika 7: Upute Richarda Avedona retušeru 

Brojevi na fotografijama označuju broj sekundi koliko bi određeno područje trebalo biti 

tretirano kako bi se postigla finalna verzija fotografije. [2] 

2.1.3. Digitalno retuširanje fotografija 

Prvi računalni sistem za obradu fotografije počeo se koristiti početkom 1980-ih, ubrzo nakon 

izuma mikroprocesora. Ogromni strojevi vrijedni milijune dolara poput Hell Cromacom-a, 

the Quantel Paintbox-a i Scitex Response System-a kombinirali bi uređaje za skeniranje i 

plošni tisak s programima za uređivanje fotografija i izrade izgleda stranice. Jedna je 

izraelska kompanije 1979. godine predstavila Scitex, sistem koji se prvotno koristio u 

industriji tekstila a koji su objeručke prihvatile medijske kuće poput National Geographic, 

USA Today, Time i cijeli niz drugih novina, časopisa i reklamnih agencija. Većina je 

ondašnjih profesionalnih fotografa još uvijek snimala fotografije na film, ali jednom kad je 

dijapozitiv skeniran, za onaj oblik retuširanja koji se nekoć obavljao ručno, sada je bilo 

potrebno samo nekoliko klikova mišem.  
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U veljači 1982. godine, pomakle su se piramide u Gizi. Tog je mjeseca na naslovnici National 

Geographica osvanula fotografija koja će ostati zapamćena kao prvi veći fotografski skandal 

digitalnog doba; naime, naslovnica je prikazivala karavanu deva ispred slavnih piramida. 

Kako bi se inače vodoravna slika lijepo uklopila na okomitu naslovnicu, jedna je piramida 

digitalno premještena bliže drugoj. Iako se to činila kao manja izmjena, pokrenula je čitavu 

lavinu komentara i kritika o statusu percepcije stvarnosti kroz fotografiju kao medija 

digitalnog doba. U to je vrijeme urednik National Geographica, Wilbur E. Garret, komentirao 

odluku o toj digitalnoj izmjeni kao ništa više nego  retroaktivnoj promjeni perspektive, kao 

da je fotograf izmijenio fotografiju tako da izgleda kao da je fotografiju okinuo stojeći 

nekoliko koraka više lijevo. No reputacija koju je National Geographic imao za svoju 

prvoklasnu novinsku fotografiju u kombinaciji s  monumentalnošću piramida kao subjekta 

fotografije su tu naslovnicu pretvorili u simbol slabljenja kredibiliteta fotografije. 

 

Slika 7- Naslovnica National Geographica za veljaču 1982. 

Početkom 1980-ih fotografija je postala bitnim medijem u umjetnosti i kulturi 

postmodernizma koji je nastojao potkopati samu ideju objektivne istine u korist pluralizma, 

ironije i ambivalencije. Dok su umjetnici postmodernizma nastojali izbaciti slike iz knjiga, 

novina i časopisa, brojne promjene u računalnoj tehnologiji nastojale su pružiti mogućnost 

ispisa i digitalne manipulacije i „običnim“ ljudima. Sredinom 80-ih stolna računala su postala 

dovoljno jaka da bi mogli podržati sofisticiranije grafičke programe kao primjerice Aldus 

Pagemaker i Adobe PostScript, i tako omogućiti dizajnerima da stvaraju i ispisuju raspored 
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stranica koje bi obuhvaćale slike i tekst u WYXIWYS formatima („what you see is what you 

get“- što vidiš to i dobiješ).  

Godine 1987., Thomas Knoll, doktorand računalne tehnologije na Sveučilištu Michigan i 

njegov brat John koji je radio na specijalnim efektima u studiju Georga Lucasa, stvorili su, 

poboljšali i proširili program za prikaz slika na crno-bijelim monitorima Macintosh Plus 

računala. Nazvali su ga Display te se bazirao na njihovom iskustvu ispisivanja crno-bijelih 

fotografija kao i fotografija u boji u tamnoj komori koju je njihov otac postavio u podrumu 

obiteljskog doma. Neki od alata koje su razvili kao dio Displaya su direktno odgovarali 

tehnikama koje su se koristile u tamnim komorama, kao što su to, primjerice, obrezivanje, 

osvjetljivanje, potamnjivanje i podešavanje zasićenosti boja, dok su drugi uključivali dodatke 

za efekte slične onima iz specijalnih filmskih efekata, poput „ripple“, „pich“ ili drugih opcija 

za iskrivljavanje fotografije. 

Nakon toga su braća Knoll s Adobe-om potpisali ugovor o licenciji, te je njihov program u 

veljači 1990. pušten u prodaju pod nazivom Photoshop 1.0. Iako je program prvotno bio 

namijenjen grafičkim dizajnerima i stručnjacima za grafičku pripremu koji su se već služili 

programima poput PostScripta ili Illustratora, Photoshop su uskoro prihvatili i komercijalni 

fotografi koji su taj program koristili za obrađivanje modnih i reklamnih fotografija. 

Naposlijetku, krajem 1990-ih s razvojem i porastom prodaje digitalnih kamera, milijuni 

novih korisnika počelo je koristiti Photoshop za obradu vlastitih fotografija. [3]  

2.2. PROCES RETUŠIRANJA FOTOGRAFIJA  

Tehnike koje će se koristiti za obradu fotografije uvelike ovise o krajnjoj namjeni korisnika, 

tj. o kontekstu u kojem će fotografija koristiti. Činjenica da će se fotografija koristiti za crno-

bijele publikacije, ili pak za oglašavanje na internetu uvelike određuje niz odluka: od 

rezolucije fotografije pa sve do tonskog raspona i korekcije boje koje će se koristiti pri 

njezinoj obradi. U ovom ću dijelu rada prikazati korake obrade fotografije namijenjene za 

naslovnicu časopisa. 
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2.2.1 Retuširanje“beauty“ fotografije- Lice [4] 

1. Krećemo od  „raw“ fotografije- Optimalno je započeti s „raw“ ili visokokvalitetnom 

fotografijom.  Na „beauty“ fotografijama kao što je ova najvažnije je osvjetljenje, jer 

njime želimo ispuniti sjene i tako osigurati da naš model ima glatku kožu već i na 

neobrađenoj fotografiji.  

Slika 8. Krećemo od  „raw“ fotografije 

2. „Frequency separation“ za dorađivanje kože- Započinjemo obradu dupliciranjem i 

rasteriziranjem svakog od layera originalne fotografije. Zatim na drugi layer (lo) 

nanosimo filter „Gaussian Blur“  od 10 piksela , dok na gornjem layeru (hi) 

uključujemo opciju Image> Apply Image te uključujemo postavke prikazane na 

snimci zaslona ispod. Sljedeći korak uključuje namještanje „hi“ layera na opciju 

stapanja „Linear Light“ te sada možemo započeti s zaglađivanjem kože i 

ispravljanjem nepravilnosti na koži.  
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Slika 9. „Frequency separation“ za dorađivanje kože 

3. Ujednačavanje tena- odabiremo alat „Healing Brush“ pa opciju „Sample“ na vrhu 

kontrolne trake postavljamo na „Current Layer“ te započinjemo s radom na layeru 

„lo“. Krećemo od  podočnjaka modela  te ih ujednačavamo. Bitno je napraviti te 

promjene na „lo“ layeru kako bi samo ujednačili boje na fotografiji i lagano 

posvijetlili područje ispod očiju a da pritom ostavimo teksturu kože netaknutom. 

 

Slika 10. Ujednačavanje tena 

4. Dodatno ujednačavanje: sljedeći korak je stvaranje layera između „hi“ i „lo“ layera. 

Nazvat ćemo taj layer „smoothing“. Zatim odabiremo alat „Brush“ te na vrhu alatne 

trake  postavljamo opacitet kista na 10 %. Cilj ovog koraka je uzeti uzorak boje gdje 



15 
 

je koža osvjetljena pa tu istu boju pažljivo nanijeti na dijelove kože koji su u sjeni, te 

taj isti postupak ponavljamo s uzorkom boje kože u sjeni koju nanosimo na 

osvjetljenije dijelove kako bi ujednačili boju kože modela. 

 

Slika 11. Dodatno ujednačavanje 

5. Micanje nepravilnosti na koži- označit ćemo „hi“ layer i odabrati opciju „Healing 

Brush“, je još jednom provjeriti da nam je opcija „Sample“ namještena na „Current 

Layer“, te počinjemo s uzimanjem uzoraka čiste kože pa ih nanosimo na one 

nepravilnosti koje želimo prikriti. 

 

Slika 12. Micanje nepravilnosti na koži 
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6. Dodavanje kose- kosa je vrlo važni element retuširanja beauty fotografija. U ovom 

slučaju trebamo samo nadopuniti kosu oko brade modela. To učinimo tako da 

pritisnemo tipke Cmd/Ctrl+Alt/Opt+ E kako bi sve layere spojili u jedan. Zatim 

odabiremo pravokutni alat za označavanje ili „Rectangular Marquee tool” (M) te 

odaberemo dio na desnoj strani fotografije pa kliknemo Cmd/Ctrl + J kako bi taj dio 

prebacili na novi, zaseban layer. Potom na izborniku odaberemo opcije 

Edit>Transform>Flip Horizontal i povučemo ga na lijevu stranu fotografije pomoću 

alata „Move“ (V). Na layer na kojem se nalazi kosa postavljamo masku te ju 

namještamo na područje lijevo od brade modela. 

 

Slika 13. Dodavanje kose 

7. Ponovno korištenje tehnike „Frequency Separation“- ponovno koristimo tipkovnički 

prečac kako bi spojili sve layere zajedno i to prebacili na novi layer te ga putem tipki 

Cmd/Ctrl + J duplicirali. Donji layer nazivamo „lo 2“ a gornji „hi 2“. Zamaglit ćemo 

layer „lo 2“za 10 piksela te ćemo primijeniti isti postupak retuširanja layera „hi 2“ 

kao što smo to prethodno učinili. Zatim biramo opciju Filter > Sharpen > Smart 

Sharpen te namještamo 150 %  izoštravanja od 1.2 piksela na „hi 2“ layeru. Isto tako, 

layeru „hi 2“ dodajemo layer mask koji ćemo kasnije uređivati. 
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Slika 14. Ponovno korištenje tehnike „Frequency Separation“ 

8. Nastavljamo sa ujednačavanjem tonova: odabrat ćemo layer „lo 2“ i uključiti alat 

„Brush“ (B) i ponovno obojati osvjetljene i osjenčane dijelove kože kao što smo to 

učinili prije nekoliko koraka. Pritom ćemo opacitet postaviti na 10 % kako bi ublažili 

omjer svjetlosti i sjene. Ovog puta ćemo se ponajprije usredotočiti na detalje. 

 

Slika 15. Nastavljamo s ujednačavanjem tonova 

9. Ujednačavanje kože- ovdje želimo ublažiti detalje na koži. Kako bi ujednačili kožu, 

layer masku koju smo dodali „h2“ layeru bojimo crnom. Koristimo alat „Brush“ 
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namješten na opacitet od 10 % i lagano bojimo po onom dijelu lica na kojem želimo 

ukloniti nepravilnosti. 

 

Slika 16. Ujednačavanje kože 

10. Dodavanje nove teksture kože- sljedeći korak uključuje dodavanje umjetne teksture 

koži kako ona ne bi izgleda previše umjetno i zaglađeno. Stvaramo novi layer i 

nazivamo ga „Skin Texture Small“ pa u izborniku „Edit“ odaberemo opciju “50% 

Gray” i zatim Filter>Noise>Add Noise. „Noise“ postavljamo na 25 %, te označimo 

kućice pored opcija “Uniform” i “Monochromatic”. Nakon toga ponovno biramo 

Filter>Stylize>Emboss te kod opcije „angle“ upisujemo 85 stupnjeva, kod „hight“ 

„2“, te kod amount 200%. Na kraju uključujemo opciju „Soft Light „ za 

ujednačavanje tog layera i tako stvaramo našu osnovnu teksturu. 
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Slika 17. Dodavanje nove teksture kože 

11. Daljnji rad na teksturi kože- dupliciramo layer na kojem se nalazi tekstura kože i 

nazovemo ga „Skin Texture Large“ i zatim odaberemo „Edit“> Transform i 

namještamo širinu i visinu na 200 % opcije „Transform“ na kontrolnoj traci na vrhu 

prozora. 

 

Slika 18. Daljnji rad na teksturi kože 

12. Stvaranje maske za teksturu- sada trebamo stvoriti masku za teksturu na onim 

mjestima gdje je to potrebno. Držimo Alt/Opt tipku i odaberemo opciju dodavanja 
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novog layera kako bi dodali masku koja je u potpunosti ispunjena crnom bojom, i to 

napravimo za oba layera s teksturama. Odaberemo alat „Brush“ (B) i ponovno 

postavljamo opacitet na 10 % i bijelom bojom lagano bojimo mjesta na kojima želimo 

da se prikaže tekstura. Najprije počinjemo s layerom nazvanim „“manjom teksturom 

i tek kasnije dodajemo veću teksturu onim mjestima kojima je to potrebno. 

 

Slika 19. Stvaranje maske za teksturu 

13. Retuširanje obrva- obrve su vrlo važne za konačni izgled. Počinjemo spajanjem svih 

layera u novi pomoću tipki Cmd/Ctrl+ Shift+ Alt/Opt+E. Korištenjem alata „Lasso“ 

(L) označavamo područja obrva koje želimo poravnati te zatim strelicama povlačimo 

ta područja prema gore. 

 

Slika 20. Retuširanje obrva 
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14. Poravnavanje obrva- pomoću tipki Cmd/Ctrl +J, označene dijelove kože premještamo 

na novi layer te pomoću alata „Move“ (V) guramo“ kožu dolje dok ne postignemo 

željeni oblik obrva. Koža ne izgleda dobro jer su rubovi označenih dijelova vidljivi. 

Dodajemo mask layer na layer „Eyebrow Trim“ i pomoću kista srednje veličine i 

mekih rubova crnom bojimo  one dijelove koji nam ne trebaju. 

 

Slika 21. Poravnavanje obrva 

15. Obrada očiju- stvaramo novi layer i nazovemo ga „Eye Blemishes“, zumiramo na oči 

i uključimo alat „Clone Stamp Tool“ (S) kako bi prekrili žilice i nepravilnosti na 

samoj očnoj jabučici. Alat „Clone Stamp“ postavljamo na opciju „Current and 

Below“, označimo „čisto“ područje očne jabučice te prekrivamo eventualne 

nedostatke na oku. 
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Slika 22. Obrada očiju 

16. Potamnjivanje očiju- stvaramo layer pod nazivom „Curves Adjustment Layer“ i 

namještamo način blendanja na „Color Burn“, baš kao što smo učinili nekoliko 

koraka ranije, te layer mask ispunimo crnom bojom. Bojimo područje oko očiju kako 

bi oči izgledale okruglije, bojimo oko šarenica kako bi se više isticale, prelazimo 

jednom preko obrva kako bi ih zatamnili, oko očiju, kako bi se više isticale, prelazimo 

malo ispod donje usne kao i preko područja između usana. 

 

Slika 23. Potamnjivanje očiju 
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17. Naglašavanje šarenica: stvaramo dva layera i nazivamo ih „Brighter“ i „Darker“ , 

uzimamo alat „Brush“ (B) te postavljamo opacitet na 20%. U ovom slučaju koristimo 

kist oštrih rubova, veličine 2 piksela, na bijeloj podlozi te bojimo preko layera 

„Brighter“. Na onim mjestima gdje primjećujemo svjetlinu na šarenici, crtamo male 

točke svjetlosti. Zatvaramo layer klikom na malu ikonicu oka te ponavljamo isti 

postupak na layeru „Darker“ samo što ovaj put prelazimo crnom bojom na onim 

mjestima gdje je šarenica najtamnija. Provjeravamo jesu li oba layera vidljiva te 

namjestimo način blendanja na „Overlay“. Na layeru „Darker“ smanjujemo opacitet 

na 20% ,a na layeru „Lighter“ na 40 %. 

 

Slika 24. Naglašavanje šarenica 

18. Osvjetljivanje i potamnjivanje kože: Odabiremo alat „Burn Tool“ (O) te na gornjem 

dijelu kontrolne ploče na opciji „Range“ odaberemo „Midtones“, a za „Exposure“ 

stavljamo 25 %. Najprije potamnjujemo sjene a zatim se poigramo sa osvjetljenim 

dijelovima. Posebice se fokusiramo na ona područja gdje kosa dodiruje kožu te 

dodajemo kontrast na prirodnim udubljenjima kože ( oko očiju, sa strane nosa, ispod 

usana i slično).  
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Slika 25. Osvjetljivanje i potamnjivanje kože 

19. Osvjetljivanje i naglašavanje svijetlih dijelova- Prelazimo na alat „Dodge Tool“ (O) 

i na prozoru koji nam se otvara namještamo opcije „Range“ na Midtones i „Exposure“ 

na 25 %. Ovime naglašavamo svijetle dijelove lica dok istovremeno zadržavamo 

prirodni prijelaz tonova. 

 

Slika 26.Osvjetljivanje i naglašavanje svijetlih dijelova 

20. Dupliciranje i zamagljivanje- zamagljujemo naš Darker i Brighter layer pomoću 

kombinacije tipki Cmd/Ctrl+ J i zatim biramo Filter> Blur > Gaussian Blur kako bi 

taj layer „blurali“ za 50 piksela, Ukoliko djeluje prejako, smanjujemo opacitet sloja. 
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Slika 27. Dupliciranje i zamagljivanje 

21. Dodavanje kontrasta licu- Stvaramo layer i nazivamo ga „Curves Adjustment Layer“ 

tako da odaberemo Layer > New Adjustment Layer>Curves i dodajemo krivulju u 

obliku slova „S“. Ispunjavamo mask layer crnom bojom i bojimo preko lice s kistom 

bijele boje namještenim na 10 % opaciteta, kako bi licu dodali kontrast.  

 

Slika 28. Dodavanje kontrasta licu 

22. Selektiranje boje i sjenčanje- stvaramo „Selective Color Adjustment Layer“ tako da 

odaberemo Layer>New Adjustment Layer>Selective Color te namještamo kvalitetu 

crvenog kanala, bijele, srednje i crne tonove dok ne budemo zadovoljni krajnjim 

rezultatom. 
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Slika 29. Selektiranje boje i sjenčanje 
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2.3 VELIKE FOTOGRAFSKE POGREŠKE RETUŠIRANJA TIJEKOM GODINE 

Primjeri fotografija preuzeti su iz „US Magazine“ [5] i „INSIDER Magazine“ [6]. 

 

 

 

 

 

 
 
 
 
 
 
 
 

1. Nevjerojatno mršava ruka 
Avril Lavigne, naslovnica iz 

studenog, 2010. 

2. Noga Kate Winslet, GQ, siječanj, 2003. 

3. Zendayin pretjerano sužen struk, 
Modeliste Magazine, listopad 2015 4. Glava Oprah fotošopirana na tijelo Ann-Margaret, 

naslovnica TV vodiča 
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5. Lena Dunham bez lijeve ruke, Vogue, veljača, 2014 

 

 

 

 

 

 

 

 

6. Adam Levine bez komada torza, Vogue Russia, studeni 2011 7. Bokovi Demi Moore, W, 
prosinac 2009 
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3. EKSPERIMENTALNI DIO 

 

3.1. OPĆI CILJEVI RADA 

Cilj istraživanja je prikazati proces retuširanja fotografija od početnog planiranja, način 
korištenja potrebne opreme te do obrade završnih fotografija. Izrađena je fotografija slikana 
od jedne studentice Grafičkog fakulteta u Zagrebu. Serija fotografija prikazuje proces 
retuširanja korak po korak, kako što je detaljno opisano u teorijskom dijelu. Serija fotografija 
je isto tako priložena na CD-u. 

 

3.2. OPREMA 

Oprema i programe korištene za retuširanje fotografije: 

- Adobe Photoshop CC 2017 

- Adobe Lightroom CC 2017 

- Canon EOS 80D 

- Objektiv: Canon 28-80mm f/3.5-5.6 
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3.3. OBRADA FOTOGRAFIJA 

1. Krećemo od  „raw“ fotografije 

2.  „Frequency separation“ za dorađivanje kože 

 

3. Ujednačavanje tena 
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4. Micanje nepravilnosti na koži 

 

5. Ponovno korištenje tehnike „Frequency Separation“ 
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6. Nastavljamo sa ujednačavanjem tonova 

 

7. Dodavanje nove teksture kože 
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8. Stvaranje maske za teksturu 

 

 

9. Obrada očiju 
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10. Naglašavanje šarenica 
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11.  Osvjetljivanje i potamnjivanje kože 

 

12. Dodavanje kontrasta licu 
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13. Selektiranje boje i sjenčanje 
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PRIJE: 

 

KASNIJE:  
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NASLOVNICA ČASOPISA 

 



39 
 

PRIMJER BR.2: 

PRIJE:         KASNIJE: 

 

NASLOVNICA ČASOPISA:  
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PRIMJER BR.3: 

PRIJE:         KASNIJE: 

 

NASLOVNICA ČASOPISA:  
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4. REZULTATI 

Razlika između dvije fotografija je očigledna. Donja fotografija prikazuje oblik retuširanja 

fotografije s kojim se svakodnevno susrećemo i koja je zapravo normalizirana i očekivana 

kada se radi o oglašavanju ili novinama. Postoji tanka linija između  uljepšavanja lica na 

fotografiji i kompletne promjene strukture lica. Bez obzira na to, fotografije u časopisima 

više nalikuju na ilustracije nego na realistični prikaz modela. Ideja ljepote tako postaje 

fiktivnim idealom a ne realističnim prikazom. 

5. ZAKLJUČAK 

 „Ne kažem da fotografija mora predstavljati aktualnu, doslovnu i apsolutnu činjenicu…ali 

mora prikazati istinu“ Henry Peach Robinson. 

Otkako su se fotografije ljudi (iako češće žena) počele pojavljivati u reklamama koje se vrte 

na vodećim medijima, njihova su lica i tijela retuširana kako bi dostignula idealne, a zapravo 

nerealistične, standarde ljepote. Današnji standard ljepote, ako je vjerovati popularnoj kulturi 

i modnim časopisima, temelji se na  uskom struku, uskim ramenima, malom nosu i punim 

usnama. Percepcija ljepote više nije istovjetna onoj u vrijeme kada su djevojke punije figure 

bile smatrane idealom; u današnje vrijeme djevojke teže za vrlo mršavim tijelom, blijedom 

puti i dugim tanašnim  rukama i nogama. Svi su ti ideali ljepote nastali pod utjecajem tadašnje 

popularne kulture. Danas je teško pronaći fotografiju u modnom časopisu na kojoj model nije 

napravljen mršavijim, „popeglanijim“, izoštrenijim ili drukčije izmijenjenim kako bi 

odgovarao slici „idealne žene“ prema modnoj industriji. 

No, odgovor na pitanje uništava li retuširanje fotografija našu percepciju standarda ljepote 

nije jednostavan, pošto je retuširanje prisutno u tolikim sferama kreativnog izražavanja. 

Možemo zaključiti da, iako retuširanje fotografija neprestano mijenja i oblikuje reklamnu 

industriju s kojom se svakodnevno susrećemo, činjenica da su alati za retuširanje postali 

masovno dostupni svakome svakako pomaže osvješćivanju i učenju o tome kako nastaju 

nedostižni idealni koje nam modna industrija nameće, kao i otkrivanju ljepota  kreativnog 

izražavanja koje nam donose mnogobrojne opcije retuširanja fotografije.  
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